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using this
manual

This user manual has been specially

designed to guide you through the functions and
features of your mobile phone. To get started quickly,
refer to “introducing your mobile phone,”
‘assembling and preparing your mobile phone,”

and “using basic functions.”

Instructional icons

Before you start, familiarise yourself with the icons
you will see in this manual:

Warning —situations that could cause
wamne  injury to yourself or others

& Caution—situations that could cause

o=, damage to your phone or other equipment

@ Note—notes, usage tips, or additional
information

| 2 Refer to—pages with related information;
for example: » p. 12 (represents “see page
127)



—> Followed by—the order of options or
menus you must select to perform a step;
for example: In Idle mode, select
Messages —> Create message (represents
Messages, followed by Create message)

Square brackets —phone keys; for
example: [*@*] (represents the Power/
Menu exit key)

Copyright information

Rights to all technologies and products that
comprise this device are the property of their
respective owners:

* Bluetooth® is a registered trademark of the
Bluetooth SIG, Inc. worldwide.
Bluetooth QD ID: BO16189

e Java™ is a trademark of Sun Microsystems, Inc.

o \Windows Media Player® is a registered trademark
of Microsoft Corporation.

o SM5®@; SIS@ gre trademarks of SRS Labs,
Inc. CS Headphone and WOW HD technologies
are incorporated under licence from SRS Labs,
Inc.

® Wi-Fi®, the Wi-Fi CERTIFIED logo, and the Wi-Fi logo
are registered trademarks of the Wi-Fi Alliance.

» DivX® s a registered trademark of
DivX; Inc., and is used under
licence.
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ABOUT DIVX VIDEO

DivX® is a digital video format created by DivX, Inc.
This is an official DivX Certified device that plays DivX
video. Plays DivX® video up to 320x240.

ABOUT DIVX VIDEO-ON-DEMAND

This DivX® Certified device must be registered with
DivXin order to play DivX Video-on-Demand (VOD)
content. First generate the DivX VOD registration
code for your device and submit it during the
registration process. [[mportant: DivX VOD content is
protected by a DivX DRM (Digital Rights
Management) system that restricts playback to
registered DivX Certified devices. If you try to play
DivX VOD content not authorised for your device, the
message "Authorization Error" will be displayed and
your content will not play.] Learn more at
http://vod.divx.com.
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safety ana
usage
iNformation

Comply with the following precautions to avoid
dangerous or illegal situations and ensure peak
performance of your mobile phone.

& Safety warnings

'WARNING

Keep your phone away from small
children and pets

Keep your phone and all accessories out of the
reach of small children or animals. Small parts may
cause choking or serious injury if swallowed.

Protect your hearing

Listening to a headset at high volumes can
damage your hearing. Use only the
minimum volume setting necessary to hear

your conversation or music.



Install mobile phones and equipment
with caution

Ensure that any mobile phones or related equipment
installed in your vehicle are securely mounted. Avoid
placing your phone and accessories near or in an air
bag deployment area. Improperly installed wireless
equipment can cause serious injury when air bags
inflate rapidly.

Handle and dispose of batteries and
chargers with care

e Use only Samsung-approved batteries and
chargers specifically designed for your phone.
Incompatible batteries and chargers can cause
serious injuries or damage to your phone.

e Never dispose of batteries or phones in a fire.
Follow all local regulations when disposing used
batteries or phones.

e Never place batteries or phones on or in heating
devices, such as microwave ovens, stoves, or
radiators. Batteries may explode when
overheated.

e Never crush or puncture the battery. Avoid
exposing the battery to high external pressure,
which can lead to an internal short circuit and
overheating.

Avoid interference with pacemakers

Maintain a minimum of 15 cm (6 inches) between
mobile phones and pacemakers to avoid potential
interference, as recommended by manufacturers
and the independent research group, Wireless
Technology Research. If you have any reason to
suspect that your phone is interfering with a
pacemaker or other medical device, turn off the
phone immediately and contact the manufacturer of
the pacemaker or medical device for guidance.
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Turn off the phone in potentially
explosive environments

Do not use your phone at refuelling points (service
stations) or near fuels or chemicals. Tumn off your
phone whenever directed by waming signs or
instructions. Your phone could cause explosions or
fire in and around fuel or chemical storage and
transfer areas or blasting areas. Do not store or carry
flammable liquids, gases, or explosive materials in
the same compartment as the phone, its parts, or
accessories.

Reduce the risk of repetitive motion
injuries

While using your phone, hold the phone with a
relaxed grip, press the keys lightly, use special
features that reduce the number of keys you have to
press (such as templates and predictive text), and
take frequent breaks.
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& Safety precautions

CAUTION

Drive safely at all times

Avoid using your phone while driving and obey all
regulations that restrict the use of mobile phones
while driving. Use hands-free accessories to
increase your safety when possible.

Follow all safety warnings and
regulations

Comply with any regulations that restrict the use of a
mobile phone in a certain area.

Use only Samsung-approved
accessories

Using incompatible accessories may damage your
phone or cause injury.



Turn off the phone near medical
equipment

Your phone can interfere with medical equipment in
hospitals or health care facilities. Follow all
regulations, posted warnings, and directions from
medical personnel.

Turn off the phone or disable the
wireless functions when in an aircraft
Your phone can cause interference with aircraft
equipment. Follow all airline regulations and tumn off
your phone or switch to a mode that disables the
wireless functions when directed by airline
personnel,

Protect batteries and chargers from

damage

e Avoid exposing batteries to very cold or very hot
temperatures (below 0° C/32° F or above 45° C/
113° F). Extreme temperatures can reduce the
charging capacity and life of your batteries.

e Prevent batteries from contacting metal objects,
as this can create a connection between the +
and - terminals of your batteries and lead to
temporary or permanent battery damage.

e Never use a damaged charger or battery.

Handle your phone carefully and

sensibly

e Do not allow your phone to get wet—liquids can
cause serious damage. Do not handle your
phone with wet hands. Water damage to your
phone can void your manufacturer's warranty.
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Avoid using or storing your phone in dusty, dirty
areas to prevent damage to moving parts.

Your phone is a complex electronic device —
protect it from impacts and rough handling to
avoid serious damage.

Do not paint your phone, as paint can clog
moving parts and prevent proper operation.

If your phone has a camera flash or light, avoid
using it close to the eyes of children or animals.
Your phone may be damaged by exposure to
magnetic fields. Do not use carrying cases or
accessories with magnetic closures or allow your
phone to come in contact with magnetic fields for
extended periods of time.

Avoid interference with other electronic
devices

Your phone emits radio frequency (RF) signals that
may interfere with unshielded or improperly shielded
electronic equipment, such as pacemakers, hearing
aids, medical devices, and other electronic devices
in homes or vehicles. Consult the manufacturers of
your electronic devices to solve any interference
problems you experience.

Do not use the phone if the screen is
cracked or broken

Broken glass could cause injury to your hand and
face. Bring the phone to Samsung service centre to
replace the glass.



Important usage information

Use your phone in the normal position
Avoid contact with your phone’s internal antenna.

Allow only qualified personnel to service
your phone

Allowing unqualified personnel to service your phone
may result in damage to your phone and will void
your warranty.

Ensure maximum battery and charger

life

* Avoid charging batteries for more than a week, as
overcharging may shorten battery life.

e Over time, unused batteries will discharge and
must be recharged before use.

e Disconnect chargers from power sources when
not in use.

e Use batteries only for their intended purpose.

Handle SIM cards and memory cards

with care

e Do not remove a card while the phone is
transferring or accessing information, as this
could result in loss of data and/or damage to the
card or phone.

e Protect cards from strong shocks, static

electricity, and electrical noise from other devices.

® Frequent writing and erasing will shorten the life
span of memory cards.

¢ Do not touch gold-coloured contacts or terminals
with your fingers or metal objects. If dirty, wipe the
card with a soft cloth.

uoneuLou ebesn pue Aejes



uoneuLojul ebesn pue Aejes .

Ensure access to emergency services

Emergency calls from your phone may not be
possible in some areas or circumstances. Before
travelling in remote or undeveloped areas, plan an
alternate method of contacting emergency services
personnel.

Specific Absorption Rate (SAR)
certification information

Your phone conforms to European Union (EU)
standards that limit human exposure to radio
frequency (RF) energy emitted by radio and
telecommunications equipment. These standards
prevent the sale of mobile phones that exceed a
maximum exposure level (known as the Specific
Absorption Rate, or SAR) of 2.0 watts per kilogram.

During testing, the maximum SAR recorded for this
model was 0.522 watts per kilogram. In normal use,
the actual SAR is likely to be much lower, as the
phone has been designed to emit only the RF
energy necessary to transmit a signal to the nearest
base station. By automatically emitting lower levels
when possible, your phone reduces your overall
exposure to RF energy.

The Declaration of Conformity at the back of this
manual demonstrates your phone’s compliance with
the European Radio & Terminal Telecommunications
Equipment (R&TTE) directive. For more information
about the SAR and related EU standards, visit the
Samsung mobile phone website.



Correct disposal of this product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and
other European countries with separate
collection systems)

mmmm his marking on the product, accessories

or literature indicates that the product and
its electronic accessories (e.g. charger, headset,
USB cable) should not be disposed of with other
household waste at the end of their working life. To
prevent possible harm to the environment or human
health from uncontrolled waste disposal, please
separate these items from other types of waste and
recycle them responsibly to promote the sustainable
reuse of material resources.

Household users should contact either the retailer
where they purchased this product, or their local
government office, for details of where and how they
can take these items for environmentally safe
recycling.

Business users should contact their supplier and
check the terms and conditions of the purchase
contract. This product and its electronic accessories
should not be mixed with other commercial wastes
for disposal.

This EEE is compliant with RoHS.
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Correct disposal of batteries in this
product

(Applicable in the European Union and
other European countries with separate
pattery retumn systems)

This marking on the battery, manual or
packaging indicates that the batteries in this product
should not be disposed of with other household
waste at the end of their working life.

Where marked, the chemical symbols Hg, Cd or Pb
indicate that the battery contains mercury, cadmium
or lead above the reference levels in EC Directive
2006/66. If batteries are not properly disposed of,
these substances can cause harm to human health
or the environment.
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To protect natural resources and to promote material
reuse, please separate batteries from other types of
waste and recycle them through your local, free
battery retumn system.

Disclaimer

Some content and services accessible through this
device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual
property laws. Such content and services are
provided solely for your personal noncommercial
use. You may not use any content or services in a
manner that has not been authorised by the content
owner or service provider. Without limiting the
foregoing, unless expressly authorised by the
applicable content owner or service provider, you
may not modify, copy, republish, upload, post,
transmit, translate, sell, create derivative works,
exploit, or distribute in any manner or medium any
content or services displayed through this device.



‘THIRD PARTY CONTENT AND SERVICES ARE
PROVIDED "AS IS." SAMSUNG DOES NOT
WARRANT CONTENT OR SERVICES SO
PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY,
FOR ANY PURPOSE. SAMSUNG EXPRESSLY
DISCLAIMS ANY IMPLIED WARRANTIES,
INCLUDING BUT NOT LIMITED TO, WARRANTIES
OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. SAMSUNG DOES NOT
GUARANTEE THE ACCURACY, VALIDITY,
TIMELINESS, LEGALITY, OR COMPLETENESS OF
ANY CONTENT OR SERVICE MADE AVAILABLE
THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE,
SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL OR
CONSEQUENTIAL DAMAGES, ATTORNEY FEES,
EXPENSES, OR ANY OTHER DAMAGES ARISING
OUT OF, OR IN CONNECTION WITH, ANY
INFORMATION CONTAINED IN, OR AS A RESULT

OF THE USE OF ANY CONTENT OR SERVICE BY
YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES."

Third party services may be terminated or interrupted
at any time, and Samsung makes no representation
or warranty that any content or service will remain
available for any period of time. Content and
services are transmitted by third parties by means of
networks and transmission facilities over which
Samsung has no control. Without limiting the
generality of this disclaimer, Samsung expressly
disclaims any responsibility or liability for any
interruption or suspension of any content or service
made available through this device.

Samsung is neither responsible nor liable for
customer service related to the content and
services. Any question or request for service relating
to the content or services should be made directly to
the respective content and service providers.

11
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iNtroducing your
mobile phone

In this section, leam about your mobile phone’s
layout, keys, and icons.

12

Unpack

Check your product box for the following items:

e Mobile phone

e Battery

e Travel adapter (charger)

e User manual

'g gge items supplied with your phone may vary

pending on the software and accessories

available in your region or offered by your
service provider. You can obtain additional
accessories from your local Samsung dealer.



Phone layout

The front of your phone includes the following keys
and features:

Earpiece %/% \_ Front camera

lens for video
calls

— 71— louch screen
Volume key—e

Menu ke

W— Power/Menu
Dial key_| (\% exit key

Mouthpiece———

The rear of your phone includes the following keys

and features:

Multifunction —=~__Headset/
jack ?{@ TV-out cable jack
Rear camera ﬁ@ | ashoub

lens =12

Hold key —e

— 1

Gate key —;

— Battery cover

Camera key — J

w
*~——Internal antenna

',, You can lock the touch screen and keys to
J prevent any unwanted phone operations. To

lock, press the Hold key.

13
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Keys

Key

- (=) D

Menu

suoyd sjigow JnoA Bupnpoaul

Function

Meake or answer a call; InIdle mode,
retrieve recently dialled, missed, or
received numbers

Key

Hold

Function

Lock or unlock the touch screen and
keys

Access Menu mode; Shows all active
applications (press and hold)

[] Cate

Open the cube screen to access
entertainment applications; Access
the motion tutorial and motion-
activated shortcuts (press and hold)

Tum the phone on and off (press and

[i) Camera

In Idle mode, tum on the camera; In
Camera mode, take a photo or record
avideo

Power/ hold); End a call; In Menu mode,
Menu exit  retum to the main menu or retum to
Idle mode
o ‘ ,
[] Volume Adjust the phone's volume

0
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Icons
Learn about the icons that appear on your display.

Icon Definition

Signal strength

GPRS network connected

EDGE network connected

UMTS network connected

HSDPA network connected

\oice call in progress

Video callin progress

SOS message feature activated

&
&3 Browsing the web

Icon Definition

Connected to secured web page

Roaming (outside of normal service area)

Call diverting activated

|0 B

Synchronised with PC

Bluetooth hands-free car kit or headset
connected

Bluetooth activated

Alam activated

Memory card inserted

New text message (SMS)

Aw@E 08 2 §

New multimedia message (MMS)

15
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New emall message
New voice mail message
Nomal profile activated
Silent profile activated

Battery power level

o
£
=
5
£
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O

Definition

Icon
e
q
4

introducing your mobile phone
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assempling and
oreparnng your
mobile phone

Get started by assembling and setting up
your mobile phone for its first use.

Install the SIM or USIM card and
battery

When you subscribe to a cellular service, you will
receive a Subscriber Identity Module, or SIM card,
with subscription details, such as your personal
identification number (PIN) and optional services.

To use UMTS or HSDPA services, you can purchase
a Universal Subscriber Identity Module (USIM) card.

17



To install the SIM or USIM card and battery, 2. Insert the SIM or USIM card.
1. Remove the battery cover.

® Place the SIM or USIM card in the phone
with the gold-coloured contacts facing
down.

¢ Without inserting a SIM or USIM card, you
can use your phone’s non-network services
and some menus.

rg If the phone is on, press and hold [*g™] to tum "g
it off.

suoyd sjigqow JnoA Buuede.d pue Buquiesse .
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3.

Insert the battery.

Charge the battery

Before using the phone for the first time, you must
charge the battery.

1. Open the cover to the multifunction jack on the
top of the phone.

2. Plug the small end of the travel adapter into the
multifunction jack.

With the triangle
facing up

19
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Improperly connecting the travel adapter can
cause serious damage to the phone. Any

CAUTION

damages by misuse are not covered by the
warranty.

Plug the large end of the travel adapter into a
power outlet.

When the battery is fully charged (the icon is
no longer moving), unplug the travel adapter from
the power outlet.

Unplug the travel adapter from the phone.
Close the cover to the multifunction jack.

'Q About the low battery indicator

20

When your battery is low, the phone will emit
a warning tone and a low battery message.
The battery icon will also be empty and
blinking. If the battery level becomes too low,
the phone will automatically power off.
Recharge your battery to continue using your
phone.

Insert a memory card (optional)

To store additional multimedia files, you must insert a
memory card. Your phone accepts microSD™ or
microSDHC™ memory cards up to 16 GB
(depending on memory card manufacturer and
type).

77 Formatting the memory card on a PC may
U cause incompatibility with your phone. Format
the memory card only on the phone.

1. Remove the battery cover.
2. Unlock the memory card holder.

74
iy




3. Lift the memory card holder and insert a memory
card as shown.

("

5. Lock the memory card holder.
o
\\

<,
2
5t
e

6. Replace the battery cover.

To remove the memory card, remove the battery
cover, unlock and lift the memory card holder, and
remove the memory card.

21
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Attach a hand strap (optional)

1.

Remove the battery cover.
2. Slide a hand strap through the slot and hook

it

over the small projection.

N 7
FITL
=g -1-0=9=
£ \0\\\“\\\\\.

assembiling and preparing your mobile phone
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Turn your phone on and off

US i ﬂg baSiC To tum your pnone on,

1. Press and hold [*g™].

fu n C‘ti On S 2. Enter your PIN and select Confirm (if necessary).

To turn your phone off, repeat step 1 above.

LLeam how to perform basic operations and use the Switch to the offline profile

TEI BB ES G LT O] S[anons, By switching to the offline profile, you can use your

phone’s non-network services in areas where
wireless devices are prohibited, such as aeroplanes
and hospitals.

To switch to the offline profile, in Menu mode, select
Settings — Phone profiles — Offline.

',, Follow all posted wamings and directions from
J official personnel when in areas where wireless
devices are prohibited.




Use the touch screen e Drag your finger up or down to scroll through
vertical lists.

Your phone’s touch screen lets you easily select
items or perform functions. Learn basic actions to
use the touch screen.

r,, For the optimal use of the touch screen,
d remove the screen protection film before using
your phone.

® Touch an icon to open a menu or launch an ‘
application.

e Drag your finger left or right to scroll through
horizontal lists.
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Access menus

Switch applications

To access your phone’s menus,

1.

In Idle mode, select Menu or press the Menu
key to access Menu mode.

Scroll left or right to a Menu mode screen.
Select a menu or option.

Select & to move up one level; Press [*o*] to
return to Idle mode.

Use the motion sensor

Your phone features a built-in motion sensor that
switches the display from portrait to landscape
mode.

The following applications support landscape mode:

Camera, Video player, Music player, and Photo
prowser.

Your phone allows you to multi-task by running
multiple applications at the same time.

Switch from one active application to
another

1. Press and hold the Menu key to open a list of
applications.

2. Scroll to an application and select it.
To change the view mode, select Grid view.

Close applications
To close the current application, press [*@*].

To close an application that is running in the
background,

1. Press and hold the Menu key to open a list of
applications.

2. Scroll to an application and select X

25
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Access an application using the
Gate key

Access an application by snapping
the phone

To access entertainment applications,
1. Press the Gate key.

2. Select an application by rotating the cube to the
appropriate side or selecting an icon at the
bottom line of the screen.

You can launch the video player, FM radio, or
music player. You can also launch the web
browser, select a game, or access the list of
photos and videos.

26

LLearn to use a motion-activated shortcut for your
favourite applications.

1. InIdle mode, press and hold the Gate key.

2. Select Guide and follow the motion tutorial. You
can learn the following actions.
e Shake the phone quickly more than 3 times to
end an application.




e Tap the top of the phone twice within 1 second to e Quickly tilt the phone left or right and then quickly
pause or resume playback, or capture a photo. back to the initial position to launch an

; application.
Z v
7 / e

&.
3
o
B.
* Snap the phone left or right and then quickly back g“
to the initial position to launch an application. '/, ¢ To deactivate the motion tutorial the next time 3
J you press and hold the Gate key, select %
Deactivate.

® T0 access the motion tutorial, in Menu mode,
select Games and more — Motion tutorial.

3. When the entertainment applications screen
appears, snap the phone in the direction of the
appropriate shortcut (left or right).
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4. Shake the phone more than 3 times to close the
current application.

Tips for using the motion-related actions:

e Perform the actions within 1 second.

® \Wait at least 1 second before performing the
actions.

e |eamn the actions by following the motion tutorial.
’/, e The motion-related actions are for both right
’ and left hand users.

* \When you are using multiple applications at
the same time, you cannot use the motion-
related actions.

To change an entertainment application assigned to
a motion direction,

1. In Menu mode, select Settings — Motion
settings - Motion gate.

2. Select an application to be changed.

28

3. Select a menu to assign to the direction and
select Save.

4, Select Save.

Use widgets

Learn to use widgets on the widget toolbar.

w e Some of your widgets connect to web
services. Selecting a web-based widget may
incur additional charges.
® Available widgets may vary depending on
your region or service provider.

Open the widget toolbar

In Idle mode, select the arrow at the bottom left of
the screen to open the widget toolbar. You can
rearrange widgets on the widget toolbar or move
them to the idle screen.



Move the widgets to the idle screen
1. Open the widget toolbar.

2. Drag a widget from the widget toolbar to the idle
screen. You can position the widget anywhere
on the screen.

Change the widgets

1. In Menu mode, select Settings — Display and
light > Widget.

2. Select the widgets you want to include to the
widget toolbar and select Save.
Use widget packages

Group your favourite widgets together as a widget
package.

To create a widget package,

1. InIdle mode, scroll left or right to one of the idle
screens.

2. Drag a widget from the widget toolbar to the idle
screen.

To open the package, scroll left or right to the
corresponding screen.
Access help information

Learn to access helpful information about your
phone.

1. Open the widget toolbar.
2. Drag | 7|to the idle screen and select it.

3. Rotate the phone anti-clockwise to landscape
view.

4. Select a help topic to learn about an application
or feature.

5. Drag your finger to the right or left to get more
information. To retumn to the previous level, select

29
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Customise your phone

Get more from your phone by customising it to
match your preferences.
Adjust the volume of the key tones

In Idle mode, press the Volume key up or down and
adjust the key tone volume.

Adjust the vibration intensity on the
touch screen

You can adjust the intensity of the vibration when you
touch the phone screen.

1. InIdle mode, press the Volume key up or down.

2. Select Vibration and adjust the intensity of the
vibration.
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Switch to or from the silent profile

In Idle mode, select Keypad and touch and hold #
to silence or unsilence your phone.

Calibrate the screen

You can calibrate the screen so that your phone
recognises the input better.

1. In Menu mode, select Settings — Phone
settings — Calibration.

2. Touch the target on the screen.
3. Select OK.

Change your ringtone

1. In Menu mode, select Settings — Phone
profiles.

2. Select [») next to the profile you are using.



3. Select Voice call ringtone or Video call
ringtone.

4. Select a ringtone from the list and select Save.
5. Select Save.
To switch to another profile, select it from the list.

Activate Etiquette pause

You can temporarily mute all phone sounds by
placing the phone face down when Etiquette pause
is activated.

1. In Menu mode, select Settings — Motion
settings — Etiquette pause — On.

2. Select Save.

Select a wallpaper (Idle mode)
1. Scroll left or right to one of the idle screens.

2. In Menu mode, select Settings — Display and
light -~ Wallpaper.

3. Scroll left or right to an image.
4. Select Set.

',, You can also set a wallpaper while viewing a

J photo. If you set the photo as the wallpaper,
only the currently selected idle screen will be
changed.

Lock your phone
1. In Menu mode, select Settings — Security.
2. Select On under Phone lock.

3. Enter a new 4- to 8-digit password and select
Confirm.

4. Enter the new password again and select
Confirm.
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’,, e The first ime you access a menu that
d requires a password, you will be prompted to
create and confirm a password.
e Samsung is not responsible for any loss of
passwords or private information or other
damages caused by illegal software.

Unlock the touch screen with smart
unlock

By drawing a specified character on the locked
touch screen, you can unlock the screen only,
unlock and then make a call to a speed dial number,
or unlock and then launch an application. To set a
smart unlock character,

1. In Menu mode, select Settings — Smart
unlock.

2. Select On under Gesture unlock.
3. Select an unlock option.
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4., Select a speed dial number to dial or select an
application to launch (if necessary).

5. Select a character for the smart unlock feature.
6. Select &.
7. Select Save.

Use basic call functions

Learn to make or answer calls and use basic call
functions.

',, During a call, your phone automatically locks
’ the touch screen to prevent accidental inputs.
To unlock, press the Hold key.

Make a call

1. InIdle mode, select Keypad and enter an area
code and a phone number.

2. Select = — Voice call or press [r] to dial the
number.



For a video call, select = — Video call.
3. Toend the call, press [75™].

Answer a call
1. When a call comes in, press [F].

2. For avideo call, press [r] and select Show
me to allow the caller to see you via the front
camera lens.

3. Toend the call, press [7T].

Adjust the volume

To adjust the volume during a call, press the Volume
key up or down.

Use the speakerphone feature

1. During a call, select Speaker — Yes to activate
the speaker.

2. To switch back to the earpiece, select Speaker.

You can set the phone to activate the speaker
automatically.

1. In Menu mode, select Settings — Motion
settings —> Speaker call - On.

2. Select Save.

3. During a call, place your phone on a table or a
flat surface.

',, In noisy environments, you may have difficulty

d hearing the calls while using the speakerphone
feature. For better audio performance, use the
normal phone mode.

Use the headset

By plugging the supplied headset into the
multifunction jack, you can make and answer calls:

e o redial the last call, press the headset button,
and then press again and hold.

e To answer a call, press the headset button.
33
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e Toend a call, press the headset button.

Send and view messages

LLearn to send and view text (SMS), multimedia
(MMS), and email messages.

Send a text or multimedia message

1.

SRS
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In Idle mode, select Messages — Create
message — Message.

Select Tap to add recipient > Enter manually.

Enter a destination number and select Done.
Select the text input field.

Enter your message text and select Done.

» Enter text

For sending as a text message, skip to step 7.
For attaching multimedia, continue with step 6.

6.
7.

Select Add media and add an item.
Select Send to send the message.

Send an email

1.

In Idle mode, select Messages — Create
message —> Email.

Select Tap to add recipient — Enter manually.
Enter an email address and select Done.

Select Tap to add subject, enter a subject, and
select Done.

Select Tap to add text, enter your email text,
and select Done.

6. Select Add files and attach a file (if necessary).

Select Send to send the message.



Enter text

With your phone’s touch screen, you can enter text
and create messages or notes.

Change the text input method

When you open the text input field, the virtual keypad
appears. Select the Keypad drop-down menu and
select one of the following input methods for
entering text:

e Keypad

* Writing full sc.

® Writing box 1

e \Writing box 2

’g You can use a wide keyboard when you rotate

the phone anti-clockwise to landscape view
when entering text.

Enter text using the keypad
1. Change the text input method to Keypad.
2. Select the appropriate virtual key to enter text.
e To change case or use numbers or symbols,
select Abc or T9ADb.
e To enter text In T9 mode, select T9.

You can use the following text input modes:

Mode Function

Select the appropriate virtual key until the

HEQ character you want appears on the display.
1. Select the appropriate virtual key to enter an
entire word.
To 2. When the word displays correctly, select

Ll to insert a space. If the correct word
does not display, select an altemate word
from the list that appears.
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Enter text using the writing box 2

Number Select the appropriate virtual key to enter a 1. Change the text input method to Writing box 2.
number. 2. Write each character in the writing area at the
Symbol Select the appropriate virtual key to enter a pottom of the screen.
symbol. To change case or use numbers or symbols,
X . select Abc.
Enter text using the writing full screen
C
é' 1. Change the text input method to Writing full sc. View text or multimedia messages
g 2. Wirite each character anywhere on the screen. 1. Inldle mode, select Messages — Inbox.
g To change case or use numbers or symbols, 2. Select a text or multimedia message.
3 select Abc.
=" Enter text using the writing box 1 View an email
1. Change the text input method to Writing box 1. 1. Inldle mode, select Messages — Email inbox.

2. Write each character in the writing area at the 2. Select an account.

bottom of the screen. 3. Select Download.

Write numbers and symbols in the ?1 column at 4. Select an email or a header.
the bottom right of the writing area.

36




5. If you selected a header, select Retrieve to view
the body of the email.

Add and find contacts

Learn the basics of using the phonebook feature.

Add a new contact

1. Inldle mode, select Keypad and enter a phone
number.

Select £ —~ Add to Phonebook — New.
Select Phone or SIM.

Enter contact information.

Select Save to add the contact to memory.

SIS

Find a contact

1. InIdle mode, select Phonebook.

2. Select the search field, enter the letter of the
name you want to find, and select Done.

VYou can also drag i to select the first letter of the
name.

3. Select the contact's name from the search list.

',g

Once you have found a contact, you can:
e call the contact by selecting
¢ edit the contact information by selecting Edit
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Use basic camera functions

Learn the basics to capture and view photos and
videos.

Capture photos
1. Inldle mode, press the Camera key to tun on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Aim the lens at the subject and make any
adjustments.
e To tumn the flash on or off, select ®.
* 7o set the exposure value, select ().

4. Press the Camera key to take a photo.
The photo is saved automatically.

After capturing photos, select P to view photos.
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View photos

In Menu mode, select My files — Images > My
photos — a photo file.

Rotate the phone anti-clockwise to landscape
view. Tilt the phone to the left or right, photos will
scroll left or right automatically.

Touch and hold the screen and drag 4 to zoom
in. Double-touch the screen to exit the zoom
screen.

To categorise and view photos in a wide view,

1.
2.

In Menu mode, select Photo browser.
Rotate the phone anti-clockwise to landscape
view.

Select @] — a category to categories the
photos.
Scroll left or right to view photos.

Tilt the phone to the left or right, photos will scroll
left or right automatically.



Capture videos

1. Inldle mode, press the Camera key to tun on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select (3 to switch to Recording mode.

4. Aim the lens at the subject and make any
adjustments.
e To change the recording mode, select [m).
e To tun the flash on or off, select ®.
® To set the exposure value, select ().

5. Press the Camera key to start recording.

6. Select B or press the Camera key to stop
recording.
The video s saved automatically.

After capturing videos, select P to view videos.

View videos
Use one of the following methods to view videos.

* In Menu mode, select My files — Videos — My
video clips — a video file.

* |n Menu mode, select Video player — a video
file.

Rotate the phone anti-clockwise to landscape view.

Listen to music

Learn how to listen to music via the music player or
FM radio.

Listen to the FM radio
1. Plug the supplied headset into the phone.
2. In Menu mode, select FM radio.

3. Select Yes to start automatic tuning.
The radio scans and saves available stations

automatically. 39
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The first time you access the FM radio, you will Listen to music files

r’l
> . N
£ e prompted to start automatic tuning. Start by transferring files to your phone or memory

4. Control the FM radio using the following icons: card:
e Download from the wireless web. » p. 41

B Stetfyour phone to re-tune frequencies for  Download from a PC with the optional Samsung
— RS PC Studio. » p. 54

g k@y  Change the sound oufput * Receive via Bluetooth. » p. 60

@ Tune a radio station; Select a saved radio e Copy to your memory card. » p. 55

g W ¥ iqi0n (touch and hold) by y ) ry p.

2 — ‘ * Synchronise with Windows Media Player 11.

2 ()] Start the FM radio »D.55

= ® Turn off the FM radio After transferring music files to your phone or

? memory card,

If you want to get information about the song you

hear, select More — Find music. » p. 58 1. In Menu mode, select Music player.

2. Select a music category —> a music file.

40




3. Control playback using the following icons:

Icon Function

) Pause playback

> Play or resume playback

@ Skip backward; Scan backward in a file
(touch and hold)

@ Skip forward; Scan forward in a file (touch
and hold)

Activate the 5.1 channel surround sound
system

Change the sound effect

Change the repeat mode

Activate Shuffle mode

BEE B

Browse the web

LLeamn to access and bookmark your favourite web
pages.
',, ® You may incur additional charges for
d accessing the web and downloading media.
® The intemet menu may be labelled differently
depending on your service provider.
¢ Available icons may vary depending on your
region or service provider.

Browse web pages

1. In Menu mode, select Internet -~ Home to
launch your service provider's homepage.
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2. Navigate web pages using the following icons:

Icon Function

Use the Google services

4 » Move backward or forward on a web page
Q Refresh the current web page

L] Open a list of activated web pages

g Change the view mode

x Open a list of saved bookmarks

bl Adjust the brightness of the screen

& Access a list of browser options

Bookmark your favourite web pages

1. In Menu mode, select Internet > Bookmarks.
Select Add.

Enter a page title and a web address (URL).
Select Save.

BN

LLearn how to use various Google services.

r,, ¢ This feature may be unavailable depending
d on your region or service provider.
¢ The steps you must select to use this feature
may differ depending on your region or
service provider.

Connect to Search
1. In Menu mode, select Google —~ Search.
2. Enter a keyword in the search field.

Connect to Malil

1. In Menu mode, select Google — Mail.
2. Set up your Google account and sign in.
3. Send or receive emails.



Connect to Maps

B) soveniraanyonrgon. e
To search the map,

1. In Menu mode, select Google > Maps.
2. Scroll through the map.

3. Zoom in or out on the location you want.
To search for a specific location,

1. In Menu mode, select Google — Maps.

2. Select Menu — Search Map and enter the
address or the category of the business.

To get directions to a specific destination,
1. In Menu mode, select Google —~ Maps.
2. Select Menu — Get Directions.

3. Enter the addresses of the starting location and

the ending location.
4, Select Show directions to view on the map.

To enhance the map functionality, download GPS
data files. » p. 76
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using advanceo
functions

Leam how to
ac

Use advanced call functions

LLearn about your phone'’s additional calling
capabilities.
View and dial missed calls

Your phone will display calls you have missed on the
display.

When you have one missed call, select the call from
the event alert widget and select Voice call to dial.

When you have two missed calls or more, select the
call from the event alert widget and select Logs — a
missed call.

Call a recently dialled number

1. Inldle mode, press [F] to display a list of
recent numbers.



2.

Select the number you want and select [ or
press [m] to dial.

Hold a call or retrieve a held call

Select Hold to place a call on hold or select
Retrieve to retrieve a held call.

Dial a second call

If your network supports this function, you can dial
another number during a call:

1.
2.

3.

Select Hold to place the first call on hold.

Enter the second number to dial and select New
call or press [F—].

Select Swap to switch between the two calls.
To end the call on hold, select On hold — (=)
To end the current call, press [7&].

Answer a second call

If your network supports this function, you can
answer a second incoming call:

1.

Press [F] to answer the second call.
The first call is automatically placed on hold.

2. Select Swap to switch between the calls.

Make a multiparty call (conference call)

1.

Call the first party you want to add to the
multiparty call.

While connected to the first party, call the
second party.

The first party is automatically placed on hold.
When connected to the second party, select
Join.

Repeat steps 2 and 3 to add more parties (if
necessary).
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5. To end the multiparty call, press [*o*].

Call an international number

1. Inldle mode, select Keypad and touch and hold
0 to insert the + character.

2. Enter the complete number you want to dial
(country code, area code, and phone number),
and then select 5] — Voice call or press ]
to dial.

Call a contact from the phonebook

You can call numbers directly from the phonebook
using stored contacts. » p. 37

1. InIdle mode, select Phonebook.
2. Select the contact you want.
3. Select [ next to the number you want to dial —

[}

46

Reject a call

To reject an incoming call, press [7&]. The caller will
hear a busy tone.

To reject calls from certain numbers automatically,
use the auto rejection. To activate the auto rejection
and set up the reject list,

1.

NO Ok N

In Menu mode, select Settings — Application
settings — Call — All calls — Auto reject.

Select On under Activation.

Select Add number.

Select the number input field.

Enter a number to reject and select Done.
Select the check box next to the number.
Select Save.



Use advanced phonebook functions

Learn to create namecards, set favourite numbers,
and create groups of contacts.

Create a namecard

1. Inldle mode, select Phonebook — More - My
namecard.

2. Enter your personal detalls.
3. Select Save.

r,, You can send your namecard by attaching it to
J a message or email or transferring it via the
Bluetooth wireless feature.

Set favourite numbers
1. InIdle mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Favourites.

3. Select Add.

4, Select a contact.
The contact is saved to the favourite number.

r,, The first 5 favourite numbers will be assigned
’ to the favourite contacts ([@&j) on the widget
toolbar.

Create a group of contacts

By creating groups of contacts, you can assign
group names, ringtones, caller ID photos, and
vibration type to each group or send messages and
emalils to an entire group. Start by creating a group:

1. Inldle mode, select Phonebook.

2. Select the Contacts drop-down menu and
select Groups.

3. Select Create group.

4. Set a group name, the caller ID photo, a group
ringtone, and vibration type.

5. Select Save.
47
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Link your photos to contacts

Learn to tag faces in your photos to make calls or
send messages from photos.

To link your photos to contacts,

1. In Menu mode, select Photo contacts.

2. Select Add — a photo.

3. Select Edit to add a tag to a person’s face.
4

. Select Add tag, move or resize the rectangle on
a face, and select Done (if necessary).

5. Select the face tag — Link to Phonebook — a
contact.
The selected contact is linked to the photo.

6. Select & to add more photo contacts (step 2).

48

Make calls or send messages from
photos

1. In Menu mode, select Photo contacts.

2. Scroll up or down to a photo.
The face tag appears with the name.

3. Select the face tag — Voice call, Video call, or
Message.

Use advanced messaging functions

LLeamn to create and use templates to create new
messages, and create message folders.

Create a text template

1. Inldle mode, select Messages — Templates —
Text templates.

2. Select Create to open a new template window
and enter your text.

3. Select Save.



Create a multimedia template Create a message from a multimedia
1. Inldle mode, select Messages — Templates > template

Multimedia templates. 1. Inldle mode, select Messages — Templates —
2. Select Create to open a new template window. Multimedia templates.
3. Create a multimedia message, with a subject 2. Select the template you want.
and desired attachments, to use as your 3. Select Send.
template. » p. 34 Your template opens as a new multimedia %
4, Select Save. message. @
Q
<
Insert text templates in new messages Create a folder to manage messages 3
®
1. To start a new message, in Idle mode, select 1. Inldle mode, select Messages — My folders. g
Messages — Create message — a message 2. Select Create folder. 3
e. &
P 3. Enter a new folder name and select Done. 3
2. Select More — Insert > Text template > a
template. Move messages from the Inbox to your folders to

manage them as your preferences.
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Use advanced camera functions

LLearn how to capture photos in various modes and

customise camera settings.

Capture photos by using options preset

for various scenes

1. Inldle mode, press the Camera key to tumn on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

3. Select — a scene — OK.
4. Make any necessary adjustments.
5. Press the Camera key to take a photo.

Capture a series of photos

1. Inldle mode, press the Camera key to tun on
the camera.

50

@

Rotate the phone anti-clockwise to landscape
view.

Select [ ~ Continuous.
Make any necessary adjustments.

Press and hold the Camera key to take a series
of photos.

Capture panoramic photos

1.

o 0k

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
view.

Select [ — Panorama.

Select a direction.

Make any necessary adjustments.

Press the Camera key to take the first photo.



8.
9.

Slowly move the phone to the direction you
selected. The phone captures the next photo
automatically.

Repeat step 7 to complete the panoramic photo.
Select [m to save the panoramic photo.

Capture photos in Smile shot mode

1.

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
View.

Select [ — Smile shot.

Press the Camera key.

Aim the camera lens at your subject.

Your phone recognises people in an image and

detects their smiles. When the subject smiles,
the phone automatically takes a photo.

Capture divided photos

1.

In Idle mode, press the Camera key to turn on
the camera.

Rotate the phone anti-clockwise to landscape
view.

Select [ —~ Mosaic.

Select an image layout and press the Camera
key.

Make any necessary adjustments.

Press the Camera key to take photos for each
segment.

Capture photos with decorative frames

1.

2.

In Idle mode, press the Camera key to turm on
the camera.

Rotate the phone anti-clockwise to landscape
view.
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Select [ — Frame.
Select a frame and press the Camera key.
Make any necessary adjustments.

Press the Camera key to take a photo with the
frame.

S

Capture videos in slow motion

1. Inldle mode, press the Camera key to tun on
the camera.

2. Rotate the phone anti-clockwise to landscape
view.

Select (31 to switch to Recording mode.
Select [m — Slow motion.
Press the Camera key to start recording.

Select B or press the Camera key to stop
recording.

S
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Use camera options

Before capturing a photo, select @ to access the
following options:

Option Function

Timer Select the time delay

Resolution Change the resolution option

White balance Adjust the colour balance of the

photo
Effects Apply a special effect
ISO Adjust the sensitivity of camera
imaging sensor
Exposuremeter  Select a type of exposure metring
Focus mode Change the camera focus
Anti-Shake Reduce blur caused by vibration or

movement




Option Function

Adjust the camera’s sensitivity to a

Option Function

Adjust the camera’s sensitivity to a

WHER wide range of available light WHER wide range of available light
Set the camera to capture a photo Video quality Adjust the quality of your video clips
Blink detection a‘ga\n automatically when people et Adjust contrast, saturation, and
close eyes I sharpness
Image quality Set the quality of your digital photos =
Adjust Adjust contrast, saturation, and Customise camera settings é
sharpness Before capturing a photo, select 8% — {03 to g
) , access the following settings: g
Before capturing a video, select @ to access the 2
following options: Setting Function g
n . . . . 3
N Oicoioy o ghidelnes
Timer Select the time delay ‘ Set tlhe camera to switch tq the =
- Review preview screen after capturing
Resolution Change the resolution option photos
White balance AgJUST t‘he colour balance of the GPS Set the camera to record GPS
video clip connection information to photos

Effects Apply a special effect




Use advanced music functions

fhel!‘igrzgt?g;‘d to accompany the LLeam to prepare music files, create playlists, and
store radio stations.

Shutter sound

Select a memory location to store

Storage Lo . .
9 new photos Copy music files via Samsung PC Studio
Before capturing a video, select §83 —~ {8} toaccess 1+ In Menu mode, select Settings > Phone
7 the following settings: settings - PC connections ~ Samsung PC
3 — e studio or Mass storage — Save.
§ 2. Press [*g*] to retum to Idle mode.
2 Guidelines Display the guidelines ) )
2 A d o - o 3. Using an optional PC data cable, connect the
= ualo recording | Tum the audio on or o multifunction jack on your phone to a PC.
S Storage Select da me‘”ﬁOW location to store 4. Run Samsung PC Studio and copy files from the
% New video clps PC to the phone.
Refer to the Samsung PC Studio help for more
information.




Copy music files to a memory card

1.
2.

Insert a memory card.

In Menu mode, select Settings — Phone
settings > PC connections —~ Mass storage
— Save.

Press [7g™] to retumn to Idle mode.

Using an optional PC data cable, connect the
multifunction jack on your phone to a PC.
When connected, a pop-up window will appear
on the PC.

Open the folder to view files.

Copy files from the PC to the memory card.

Synchronise your phone with Windows
Media Player

1.
2.

Insert a memory card.

In Menu mode, select Settings — Phone
settings — PC connections — Media player —~
Save.

Press [*g*] to return to Idle mode.

Using an optional PC data cable, connect the
multifunction jack on your phone to a PC with
Windows Media Player installed.

When connected, a pop-up window will appear
on the PC.

Open Windows Media Player to synchronise
music files.

Edit or enter your phone’s name in the pop-up
window (if necessary).
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7. Select and drag the music files you want to the Access the album list

sync list. 1. During playback, rotate the phone anti-clockwise
8. Start synchronisation. to landscape view.

2. Scroll to an album and select it.

3. Select a music file to play it.
Select (W) or (») to pause or resume the current

Create a playlist
1. In Menu mode, select Music player — Playlists.

7 2. Select Create. playback.
é 3. Enter a title for your new playlist. c . . .
g 4. To assign an image to the playlist, select Tap to ustomise your music player settings
3 edit and select an image or capture a new 1. In Menu mode, select Music player.
g photo. 2. Select Settings.
2
& 5. Select Save. 3. Adjust the settings to customise your music
7 6. Select the new playlist. player.
7. Select Add > Tracks.
8. Select the files you want to include and select Background get LZVheThedr tohp‘ay mUS‘Cd‘”ththe
Add. oleing ackground when you end the

music player
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Sound

offects Select the default equaliser type

Select a background image during
playback

Select music categories to display in
the music library screen

Visualisation

Music menu

4. Select Save.

Record songs from the FM radio

1. Plug the supplied headset into the phone.
2. In Menu mode, select FM radio.

3. Select (») to start the FM radio.

4. Select More — Record to start recording.

5.

When you are finished recording, select Stop.
The music file will be saved in Radio clips (in
Menu mode, select My files - Sounds).

'g The recording feature is developed for voice

recording only. The quality of the recording will
pe much lower than digital media.

Store radio stations automatically

1.

Plug the supplied headset into the phone.

2. In Menu mode, select FM radio.
3.
4, Select Yes to confirm (if necessary).

Select More — Self-tuning.

The radio scans and saves available stations
automatically.
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Find information of music

Learn to access an online music service and get
information about the songs you hear while on the
move.

1. In Menu mode, select Find music.
2. Select Find music to connect to the server.

3. When your phone is successfully registered,
select (o) to record a part of music you want to
find.

',, Some service providers may not support this
d service and the database may not have
information for all songs.
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Use the Bluetooth wireless feature
: Zor A AR T EEee e
U Sl n ‘tOO | S an d LLearn about your phone's ability to connect to other
wireless devices for exchanging data and using
hands-free features.

app| |Ca—t|on8 Turn on the Bluetooth wireless feature

. . ) 1. In Menu mode, select Bluetooth.
Leam how to work with your mobile phone's tools o
and additional applications. 2. Select the circle in the centre to tum on the

Bluetooth wireless feature.

3. To allow other devices to locate your phone,
select Settings — On under My phone’s
visibility — a visibility option - Save — Save.
If you selected Custom, set duration that your
phone is visible.
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Find and pair with other Bluetooth-
enabled devices
1. In Menu mode, select Bluetooth — Search.
2. Select and drag a device icon into the centre.
3. Enter a PIN for the Bluetooth wireless feature or
the other device's Bluetooth PIN, if it has one,
and select Done.
When the owner of the other device enters the

same PIN or accepts the connection, pairing is
complete.

77 You may not need to enter a PIN depending on
fd the device.
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Send data using the Bluetooth wireless

feature

1. Select the file or item from one of your phone’s
applications that you want to send.

2. Select Send via or Send URL via — Bluetooth.

Receive data using the Bluetooth

wireless feature

1. Enter the PIN for the Bluetooth wireless feature
and select OK (if necessary).

2. Select Yes to confirm that you are wiling to
receive data from the device (if necessary).



Use Remote SIM mode

In Remote SIM mode, you can make or answer calls
only with a connected Bluetooth hands-free car kit
via the SIM or USIM card on your phone.

To activate Remote SIM mode,
1. In Menu mode, select Bluetooth — Settings.

2. Select On under Remote SIM mode — Save.

To use Remote SIM mode, start the Bluetooth
connection from a Bluetooth hands-free car kit.

r,, The Bluetooth hands-free car kit must be
’ authorised. To authorise, select the device and
select Authorise device.

Activate and connect to a wireless
LAN (WLAN)

LLearn to activate and connect to a wireless LAN.

rg Your device uses a non-harmonised frequency
and is intended for use in the following
countries: United Kingdom, Greece, Latvia,
Lithuania, Estonia, Sweden, Denmark, Finland,
Norway, Portugal, Poland, Italy, Bulgaria,
Germany, Austria, France, Switzerland,
Kazakhstan, Russia, Ukraina.

Activate a WLAN
1. In Menu mode, select Wi-Fi.

2. Select the circle in the centre to activate a
WLAN.

"ﬂ The activated WILAN in the background will
consume battery power. To preserve battery
power, activate the WLAN only when needed.
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Search for and connect to a WLAN
. In Menu mode, select Wi-Fi — Search.
2. Select a network icon - Add and add a

connection profile.

o [f the network you want needs an IP address,

subnet mask, DNS, or gateway information,
select Advanced settings.

® Wi-Fi security should be set as the selected
network configuration and 802.1x (EAP-
TTLS, PEAP) is supported.

. InMenu mode, select Internet or Communities,

or in Idle mode, select a web-based widget.
Your phone connects to the network using the
connected WLAN profile.

rg To access the intemet via another method,

change the connection profile to the desired
method.

Activate and send an SOS message

In case of an emergency, you can send an SOS
message asking for help.

'g This feature may be unavailable depending on

1.

NOo Ok ®

your region or service provider.

In Idle mode, select Messages > SOS
messages — Sending options.

Select On to turn on the SOS messaging
feature.

Select the recipient field to open the recipient list.
Select ¥ to open your contact list.

Select the contacts you want and select Add.
Select a phone number (if necessary).

Select OK to save the recipients.



8. Select the Once drop-down menu and select Activate the mobile tracker
the number of times to repeat the SOS - -
message. When someone inserts a new SIM or USIM card in

your phone, the mobile tracker feature will
automatically send the contact number to two

9. Select Save ~ Yes.

To send an SOS message, the touch screen and recipients to help you locate and recover your
keys must be locked. Press the Volume key four phone. To activate the mobile tracker,
times.

1. In Menu mode, select Settings — Security —>
r,, Once you send an SOS message, all phone Mobile tracker.
’ functions will be suspended until you press the
Hold key. If you press [7&*], phone functions
will be available, but the keys will remain
locked.

Enter your password and select Confirm.

Select On to tumn on the mobile tracker.

Select the recipient field to open the recipient list.
Enter a phone number.

Select OK to save the recipients.

Select the sender input field.

Enter the sender’s name.

Select Save ~ Accept.
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View the phone display on a TV

Make fake calls

Learn to view files by connecting your phone to a TV.
1.

With the TV on, connect your phone to the TV
with a TV out cable.

Switch the TV to the appropriate external input
mode.

If you cannot view the phone via the TV, try
changing the TV-out settings: In Menu mode,
select Settings — Phone settings — a video
encoding system under TV out.

rg Your files may not display correctly, due to

differences in video systems or quality of the TV
display. The Bluetooth stereo headset and
zoom functions will not work in TV-out mode.

You can simulate fake incoming calls when you want
to get out of meetings or unwanted conversations.
You can also make it appear as if you are talking on
the phone by playing back a recorded voice.

Record a voice

1. In Menu mode, select Settings — Application
settings —> Call — Fake call —~ Fake call voice.

Select On under Fake call voice.

Select Voice recording.

Select (e to start recording.

Speak into the microphone.

When you are finished speaking, select ().

Select & to set the recording as a response for
the fake call.

8. Select Save.

NOoO Ok N



Make a fake call Play a voice memo

Record a voice memo

1. In Menu mode, select Voice recorder.
2. Select (o) to start recording.

3. Speak your memo into the microphone.
4

. When you are finished speaking, select (m).
Your memo is saved automatically.

To make a fake call, press and hold the Volume key 1. In Menu mode, select My files -~ Sounds —
down in Idle mode. Voice clips.
To change the delay time before fake calls, in Menu 2. Select afile.
mode, select Settings — Application settings — 3. Control the playback using the following icons:
Call — Fake call — Fake call timer — an option — -
Save. .
) Pause playback é'
Record and play voice memos &)  Playorresume playback g
N " 2]
LLearn to operate your phone’s voice recorder. @ Scan backward in a file (touch and hold) 3
») Scan forward in a file (touch and hold) §
%
o
?
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Edit images

Learn to edit images and apply fun effects.

Apply effects to images

1. In Menu mode, select My files > Images > My
photos — a photo file.

2. Select &),

3. Select Edit — Effects — an effect option (filter,
style, warp, or partial blur).

4. Select a variation of the effect to apply and select
Done.

To apply a blur effect to a specific area of an
image, draw the rectangle and select Blur —
Done.

5. When you are finished with applying effects,
select Files — Save as.

6. Select a memory location (if necessary).

7. Enter a new file name for the image and select
Done.

Adjust an image

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit > Adjust — an adjustment option
(brightness, contrast, or colour).
To adjust the image automatically, select Auto
level.

3. Adjust the image as desired and select Done.

4., Save the edited image with a new file name.
Refer to steps 5-7 in "Apply effects to images.”



Transform an image

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit — Transform — Resize, Rotate, or
Flip.

3. Rotate or flip the image as desired and select
Done.
To resize the image, select a size ~ Save —
Done.

4. Save the edited image with a new file name.
Refer to steps 5-7 in “Apply effects to images.”

Crop an image

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit — Crop.

3. Draw the rectangle over the area you want to
crop and select Crop — Done.

4., Save the edited image with a new file name.
Refer to steps 5-7 in "Apply effects to images.”

Insert a visual feature

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”

2. Select Edit — Insert — a visual feature (frame,
image, clip art, emoticon, or text).

3. Select a visual feature, or enter text and select
Done.

4. Move or resize the visual feature or text and
select Done.

5. Save the edited image with a new file name.
Refer to steps 5-7 in "Apply effects to images.”

Add a memo by handwriting

1. Open an image to be edited. Refer to steps 1-2
in “Apply effects to images.”
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2. Select Edit ~ Memo on screen.

3. Select a colour, write a memo on the screen,
and select Done.

4. Save the edited image with a new file name.
Refer to steps 5-7 in “"Apply effects to images.”

Print images

Learn to print your image with a USB connection or
the Bluetooth wireless feature.

To print an image using a USB connection,

1. Connect the multifunction jack on your phone to
a compatible printer.

2. Open animage. » p. 38
3. Select More — Print via >~ USB.
4. Set print options and print the image.
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To print an image using the Bluetooth wireless
feature,

1.
2.
3.

4.

Open an image. » p. 38
Select More — Print via — Bluetooth.

Select a Bluetooth-enabled printer and pair with
the printer. » p. 60

Set print options and print the image.

Edit videos

Learn to edit video files and apply visual effects.

Trim any segment

1.
2.

In Menu mode, select Video editor.
Select Files — Import image or Import video.



. Select an image or video category — an image
or video and select Add.

For an image, select the duration that the image
displays.

. Select More — Files to add more images or
videos.

. Select Edit — Trim.

. Select (») to play the video and select Start
mark at the point where you want the new video
to begin.

. Select End mark at the point where you want
the new video to end.

. Select Trim.

. When you are finished, select More — Export —
Video — Yes.
To save the project for future use, select More —
Files — Save project. The project will be saved
in Other files.

10. Enter a new file name and select Done.
11.To check the file, select Yes (if necessary).

Split videos

1.

Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”

Select Edit — Split.

Select (») to play the video and select Split
point — Split to divide the file into two clips.

Insert an image or video as desired between the
clips.

Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”

69

o
@.
=}
@
=
g
o]
[
o
2
a
jo)
S
S
2
2
5]
2
2]




o
@.
=}
@
=
g
o]
[2)
o
2
a
jo)
ke}
S
2
2
5
2
2]

Insert text

77 Inserting text to a video may be unavailable
U depending on your service provider.

1. Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”

2. Select Edit — Insert > Text.

3. Select (») to play the video and select Start
mark at the point where you want the text to be
displayed.

4. Select End mark at the point where you want
the text to be disappeared.

5. Select Insert.
6. Enter text and select Done.

7. Move or resize the text and select Done.
To change the text colour, select Colour.

70

8.

Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”

Add sound track

1.

Open images and videos to be edited. Refer to
steps 1-4 in “Trim any segment.”

Select Additional audio track — Import sound.
Select Sounds — a sound category = a sound.

Save the edited video with a new file name. Refer
to steps 9-11 in “Trim any segment.”

Upload photos and videos to the
web

LLearn to post your photos and videos to photo
sharing websites and blogs.

ﬁ Communities may be unavailable depending

£

on your region or service provider.



Set your favourite destination list
1. In Menu mode, select Communities.

2. Select Yes to set your favorite destination list (if
necessary).

3. Select Accept to confirm that you agree to the
general disclaimer.

r,, The first time you access Communities, you
d will be prompted to confirm.

4. Select the destinations you want to add and
select Save.
If you selected Update lists, new destination
sites are added to the list automatically.
’/, To edit the favourite destination list or update the
J lists, from the Communities screen, select
Settings — Preferred lists ~ Edit.

Upload a file

To upload photos and videos, you must have
accounts of photo sharing websites and blogs.

1. In Menu mode, select Communities.
2. Select a destination you want to post to.

3. Enter the user ID and password of the
destination.

4. Select Tap to add and select a media file.

5. Enter the post details and select Upload to
web.
r,, You can also upload media files from Camera
’ or My files, by selecting @& or More —
Upload to web.
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Use Java-powered games and
applications

Learn to use games and applications powered by
award-winning Java technology.

77 he download of java files may not be
supported depending on the software of the
phone.

Download games or applications

1. In Menu mode, select Games and more —
More games.
Your phone connects to the website preset by
your service provider.

2. Search for a game or application and download it
to the phone.

72

Play games
1. In Menu mode, select Games and more.

2. Select a game from the list and follow the on-
screen instructions.

',, Available games may vary depending on your
J region or service provider. Game controls and
options may vary.

Launch applications

1. In Menu mode, select Games and more — an
application.

2. Select More to access a list of various options
and settings for your application.



Synchronise data

Learn to synchronise the contacts, calendar events,
tasks, and memos with the web server you have
specified. To synchronise the contacts, calendar
events, tasks, and emalils, specify a Microsoft
Exchange server.

Synchronise data with a web server
To create a synchronisation profile,

1. In Menu mode, select Synchronise.

2. Select Add and specify profile parameters.
3. When you are finished, select Save.

To start synchronisation,

1. In Menu mode, select Synchronise.

2. Select a synchronisation profile.

3. Select Continue to start synchronisation with the
web server you have specified.

Synchronise data with a Microsoft
Exchange server

77 Youmay only use the Microsoft® Exchange
" ActiveSync® feature in this phone with a
service that is licensed by Microsoft
Corporation to use Microsoft® Exchange
ActiveSync®,

To set a Microsoft Exchange server and
synchronisation profile,

1. In Menu mode, select Exchange ActiveSync.
2. Specify Microsoft Exchange server settings.

3. Select Save.
4

. Specify an email connection profile by following
the emall setup wizard.

5. When you are finished, select Save.
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6. Select a synchronisation profile.
Synchronisation with the Microsoft Exchange
server you have specified starts.

’,, ‘You may incur additional charges for accessing
d the server.
To synchronise all items,

1. In Menu mode, select Exchange ActiveSync.
2. Select Sync.

r,, If you synchronise all items, you may incur

J charges for updating unnecessary items.
To synchronise emails only,
1. In Menu mode, select Exchange ActiveSync.
2. Select Email — Inbox — Sync — Email.
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Use RSS feeds

Lean to use RSS feeds to get the latest news and
information from your favourite websites.

Add an RSS feed address

1.

o

In Menu mode, select Internet — RSS feeds.

2. Select Add.
3.
4. Enter the address of an RSS feed and select

Select the address input field.

Done.
Select OK.
Select = — Add RSS feed.



Update and read RSS feeds If this feature is not provided as default depending on
your region or service provider, you can install the

1. In Menu mode, select Internet — RSS feeds. navigation application by yourself.

2. Select Update > afeed > Update - Yes. 1. In Menu mode, select Settings — Phone

3. Select a feed category - an updated feed. settings — Navigation — On.
The auto update feature sets the phone to ;

W automaﬂcaﬁy update the RSS feegs atthe 2. Insert a memory ciard ‘|nto thelphc?ne, > p.20
specified interval. You can activate the auto 3. Download the navigation application to the .
update feature by selecting Internet — memory card using the Samsung PC studio. 3
Settings > RSS update. 4. Purchase a licence to use the navigation 8

application. §

Launch the Samsung Mobile For detals or the user manual, visit o

N avigator http://www.66.com/samsung. §_

. i i igati icati =

In Menu mode, select Navigation. w \r/r;/rq‘(?v:st‘r?g msee?%\gg;tle?;ﬁ;%gﬂon' dorot g

For detalls, refer to the quick start guide of the e This feature may be unavailable depending

Samsung mobile navigator. On your region or service provider.

75




o
@.
=)
«Q
o
o
o
2
[oR
Qo
e}
T
=3
2
[e)
=}
(2]

View your current position

LLearn to determine the latitude, longitude, and
altitude of your current position using the global
navigation satellite system. You must be in outdoors
for using the satellite.

In Menu mode, select Settings — Phone settings
— GPS settings —> GPS position.

Update the GPS functionality

Learn to enhance the GPS functionality by
downloading GPS data files. You can improve the
speed and accuracy of positioning capability and
expand your navigation to areas where cellular
networks are not accessible.

1. In Menu mode, select Settings — Phone
settings - GPS settings ~> GPS+ settings —
Download data.
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2. Select Yes to connect to a server and download
GPS data files.

'/, If your phone has the navigation feature, you

“ can use a Bluetooth-enabled GPS device.
Change the connection type. In Menu node,
select Settings > Phone settings ~ GPS
settings — GPS navigation via —
Bluetooth GPS.

Create and view world clocks

Leamn to view the time in another region and set
world clocks to appear on your display.

View a world clock

1. In Menu mode, select World clock.

2. Scroll through the world map and select a time
zone you want.



Create a world clock

1.

ok W

6.

In Menu mode, select World clock.
Select @& — Add.

Select a time zone.

To set daylight saving time, select *

Select OK to create your world clock.
The world clock is set as the second clock.

Select Add to add more world clocks (step 3).

Add a world clock to your display

With the dual clock widget, you can view clocks with
two different time zones on your display.

After you have created a world clock,

1.

In Menu mode, select World clock.

2. Select & — Set as second clock.
3.
4. Select Set.

Select the world clock you want to add.

Set and use alarms

LLeamn to set and control alarms for important events.

Set a new alarm

1. In Menu mode, select Alarms.
2. Select Create alarm.

3. Set alarm details.

4. Select Save.

',, The auto power-up feature sets the phone to
’ automatically turn on and sound the alarm at

the designated time if the phone is turmed off.
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Stop an alarm
When the alarm sounds,

e Drag the slider to Stop to stop the alarm without
snooze.

e Drag the slider to Stop to stop the alarm with
snooze or drag the slider to Snooze to silence the
alarm for the snooze period.

Deactivate an alarm
1. In Menu mode, select Alarms.

2. Select Off next to the alarm you want to
deactivate.
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Use the calculator

1. In Menu mode, select Calculator.

2. Use the keys that correspond to the calculator
display to perform basic mathematical
operations.

Convert currencies or
measurements

1. In Menu mode, select Convertor —> a
conversion type.

2. Enter the currencies or measurements and units
in the appropriate fields.



Set a countdown timer

Create new tasks

In Menu mode, select Timer.
Set the length of time to count down.
Select Start to begin the countdown.

When the timer expires, drag the slider to Stop
to stop the alert.

MW=

Use the stopwatch

In Menu mode, select Stopwatch.
Select Start to begin the stopwatch.
Select Lap to record lap times.
When you are finished, select Stop.
Select Reset to clear recorded times.

SN

1. In Menu mode, select Task.
2. Select Create task.
3. Enter the details of the task and select Save.

Create text memos

1. In Menu mode, select Memo.
2. Select Create memo.
3. Enter your memo text and select Done.

Create sketches

Leamn to create sketches with various sketch tools.

79
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Create a new sketch

1.
2.

3.
4.
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In Menu mode, select Dynamic canvas.

From the sketch toolbar, select £ to change
the tool type. You have the following tools:

Tool Function

Add a line; You can select the line type, line
@
thickness, and colour

Add a circle or rectangle; You can select
the line thickness, line colour, and colour to
fill the figure

Enter text to insert; You can change the font
size, attribute, and text colour

—

& Insertastamp or an image stamp

Using the tools, make a sketch.

To delete text, stamps, or image stamps that you
added, select an item — More — Delete.

5. When you are finished, select File - Save as
Image.

6. Enter a new file name and select Done.

Add motion to a sketch
1. Make a sketch with stamps or image stamps.

2. To use the preset motion type, select More —
Motion — Preset — a stamp or an image stamp
— a motion type - OK.
To use a new motion type, select More —~>
Motion — Motion line — a stamp or an image
stamp. Draw a line to track and select Preview
to preview the motion. Select OK.

3. When you are finished, select File > Save as
Flash.

4. Enter a new file name and select Done.



Manage your calendar

Learn to change the calendar view and create
events.

Change the calendar view

1.
2.

In Menu mode, select Calendar.

Select More — View by day or View by week.

Create events

1.

In Menu mode, select Calendar.

2. Select Create — an event type.
3.
4. Select Save.

Enter the details of the event as required.

View events

To view events of a specific date,

1. In Menu mode, select Calendar.
2. Select a date on the calendar.

3. Select an event to view its details.
To view events by event types,

1. In Menu mode, select Calendar.

2. Select Event list > an event type.

3. Select an event to view its details.
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troubleshooting

If you are having trouble with your mobile phone, try these troubleshooting procedures before contacting a service
professional.

While using your phone, the following messages Message  Try this to solve the problem:

may appear: When using the phone for the first time

Message  Try this to solve the problem: or when the PIN requirement is

enabled, you must enter the PIN

insert SV PINcode ¢, pjied with the SIM or USIM card.

. Ensure that the SIM or USIM card is You can disable this feature by using

T installed correctly. the PIN lock menu.

services When you access a menu requiring
When the phone lock feature is PIN2 lock the PIN2, you must enter the PIN2

supplied by the SIM or USIM card. For

Phone lock  enabled, you must enter the password detalls, contact your service provider.

you set for the phone.




Message Try this to solve the problem: * [Ensure that you have accessed the right cellular

Your SIM or USIM card is blocked, network. |
usually as a result of entering your PIN * Ensure that you have not set call barring for the

PUK code  incorrectly several times. You must phone number.

enter the PUK supplied by your Another caller cannot reach you.
service provider.

e Ensure that your phone is tumed on.

Your phone displays “Service unavailable” or ® Ensure that you have accessed the right cellular

“Network error.” network.

* \When you are in areas with weak signals or poor e Ensure that you have not set call barring for the
reception, you may lose reception. Move to phone number.

another area and try again.

® You cannot access some options without a
subscription. Contact your service provider for

Another caller cannot hear you speaking.
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e Ensure that you are not covering the built-in

more details. microphone.
You enter a number, but the call is not dialled. ¢ rEnQiﬁrhe that the microphone is close to your
® Ensure that you have pressed the Dial key: [F—]. e If using a headset, ensure that it is properly
connected.
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The phone beeps and the battery icon flashes.

Your battery is low. Recharge or replace the battery to
continue using the phone.

The audio quality of the call is poor.
e Ensure that you are not blocking the phone’s
internal antenna.

e \When you are in areas with weak signals or poor
reception, you may lose reception. Move to
another area and try again.

You select a contact to call, but the call is not
dialled.

e Ensure that the correct number is stored in the
contact list.

e Re-enter and save the number, if necessary.

The battery does not charge properly or
sometimes the phone turns itself off.

e The battery terminals may be dirty. Wipe both
gold-coloured contacts with a clean, soft cloth
and try charging the battery again.

o |f the battery will no longer charge completely,
dispose of the old battery properly and replace it
with a new battery.

Your phone is hot to the touch.

When you use several applications at once, your
phone requires more power and may heat up.

This is normal and should not affect your phone’s
lifespan or performance.
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alarms
creating, 77

deactivating, 78
stopping, 78

battery
charging, 19
installing, 17
low battery indicator, 20

Bluetooth
activating, 59

receiving data, 60
remote SIM mode, 61
sending data, 60

browser
see web or photo browser

calculator
see tools, calculator

calendar
see tools, calendar

calls
advanced functions, 44

answering additional calls, 45
answering, 33

basic functions, 32

dialing additional calls, 45
dialing missed calls, 44

from the phonebook, 46

international numbers, 46
making fake calls, 64
making, 32

multiparty, 45

placing on hold, 45
recently dialled, 44
rejecting, 46

retrieving held calls, 45
viewing missed, 44

clock
see world clock

Communities
see tool, mobile blog
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conference calls.
see calls, multiparty

contacts
adding, 37
creating groups, 47
finding, 37
linking from photos, 48

converter
see tools, convertor

countdown timer
see tools, countdown timer

display - viewing on TV 64

Dynamic canvas
see tools, sketch memo

fake calls
see calls, making fake calls

FM radio
listening to, 39
recording songs, 57
storing stations, 57

Google services 42

headset 33

images
adding memos, 67
adjusting, 66
applying effects, 66
cropping, 67
inserting visual features, 67
printing, 68
transforming, 67

internet
see web browser

Java
accessing applications, 72

downloading, 72
launching games, 72

key tones 30

lock
see phone lock

memo
see text or voice memos

memory card 20

messages
sending email, 34
sending multimedia, 34
sending text, 34
viewing email, 36
viewing multimedia, 36
viewing text, 36



Microsoft Exchange
synchronisation 73

mobile tracker 63

multimedia
see messages

music finding 58
music player
creating playlists, 56
customising, 56
listening to music, 40
synchronising, 55
namecards 47
navigator 75
offline profile 23

phone lock 31

photo browser 38
photo contacts 48

photos
advanced capturing, 50

basic capturing, 38
editing, 66
viewing, 38
radio
see FM radio
ringtone 30

RSS feeds
see tools, RSS feeds

Samsung PC Studio 54
silent profile 30
SIM card 17

SOS message 62

stopwatch
see tools, stopwatch

synchronisation
creating a profile, 73

starting, 73

task
see tools, task

templates
inserting, 49

multimedia, 49
text, 48

text
creating memos, 79

entering, 35
messages, 34
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image editor, 66
mobile blog, 70
RSS feeds, 74
sketch memo, 79
stopwatch, 79
task, 79

video editor, 68

volume
call volume, 33

key tone volume, 30

wallpaper 31

web browser
adding bookmarks, 42

timer videos widgets 28
see tools, countdown timer advanced capturing, 52 -
. ) Wi-Fi 61
| basic capturing, 39
tooafa 77 eding, 68 Windows Media Player 55
calculator, 78 viewing, 39 world clock
) ting, 77
calendar, 81 voice memos creg )
convertor, 78 playing, 65 s§ﬁ|pg dual display, 77
countdown timer, 79 recording, 65 viewing, 76

launching homepage, 41
video player 39 9 bag
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Declaration of Conformity (R&TTE)

We, Samsung Electronics

declare under our sole responsibility that the product

GSM Mobile Phone : S8000

to which this declaration relates, is in conformity with the following
standards and/or other normative documents.

SAFETY  EN60950- 1: 2001 +A11:2004

SAR EN 50360 : 2001
EN 62209-1 : 2006

EMC EN 301 489- 01 V1.6.1 (09-2005)
EN 301 489- 07 V1.3.1 (11-2005)
EN 301 489- 17 V1.2.1 (08-2002)
EN 301 489- 24 V1.3.1 (11-2005)
EN 301 489- 24 V1.4.1 (09-2007)

RADIO EN 301 5611 V9.0.2 (03-2003)
EN 300 328 V1.7.1 (10-2006)
EN 301 908- 1 V3.2.1 (05-2007)
EN 301 908- 2 V3.2.1 (05-2007)

We hereby declare that [all essential radio test suites have been carried
out and that] the above named product is in conformity to all the
essential requirements of Directive 1999/5/EC.

The conformity assessment procedure referred to in Article 10 and
detailed in Annex(IV] of Directive 1999/5/EC has been followed with the
involvement of the following Notified Body(ies):

BABT, Balfour House, Churchfield Road,
Walton-on-Thames, Surrey, KT12 27D, UK* c € 0168 @

Identification mark: 0168

The technical documentation kept at :
Samsung Electronics QA Lab.

which will be made available upon request.
(Representative in the EU)

Samsung Electronics Euro QA Lab.

Blackoushe Business Park, Saxony Way, )O e M—

Yateley, Hampshire, GU46 6GG, UK*
2009.04.16 Yong-Sang Park / S. Manager

(place and date of issue) (name and signature of authorised person)

* Itis not the address of Samsung Service Centre. For the address or the
phone number of Samsung Service Centre, see the warranty card or contact
the retailer where you purchased your phone.



Some of the contents in this manual may differ from your phone depending on the software of the phone or your
service provider.

SAMSUNG ELECTRONICS ZZEIT™

Printed in Korea
World Wide Web Code No.:GH68-24283A
http://www.samsungmobile.com English (EU). 06/2009. Rev. 1.2
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